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Introducción 

 La vegetación es un componente esencial de la biósfera de nuestro Planeta. Sin ella, mucha 

de la vida que conocemos no existiría. Las plantas llevan a cabo un proceso fundamental para los 

seres vivos, el cual se conoce como fotosíntesis. Mediante esta reacción bioquímica, las plantas 

producen oxígeno que permite a los seres vivos con procesos metabólicos aeróbicos llevar a cabo 

respiración, y también producen azúcares que sirven de alimentos para ellas mismas y para los 

organismos heterótrofos que se alimentan de ellas. La vegetación se encuentra en diversos tamaños 

y formas, pero cada especie cumple con una función muy importante en su respectivo hábitat.  

 Existen procesos naturales que afectan la vegetación, tales como la precipitación, la fauna, 

la temperatura, los huracanes, entre otros. De igual manera, existen factores antropogénicos que 

provocan cambios en la vegetación, incluyendo la tala, la siembra, la quema intencional y el uso 

de maquinaria. Normalmente, lugares donde hoy día existen zonas urbanas o construcciones eran 

antes lugares ocupados por vegetación. Por otro lado, lugares que antes albergaban una alta 

concentración de actividad humana, y luego son abandonados, han recobrado gran parte de su 

vegetación, tal como lo son los bosques secundarios. Estos cambios se han observado y 

documentado por las personas que frecuentan esos lugares. Sin embargo, hay lugares donde no 

hay personas que puedan testificar los cambios que ha sufrido la flora, o la extension territorial 

que se quiere estudiar es demasiado grande para que esos cambios sean medidos por observaciones 

“in situ”. La percepción remota juega un papel protagónico para facilitar estos estudios. La señal 

espectral que reciben los sensores de los satélites en órbita permite calcular valores matemáticos 

que estiman la salud de un grupo de plantas o la densidad de la vegetación en un espacio dado.  

Uno de los métodos más utilizados mediante percepción remota para cuantificar la salud  

o abundancia de las plantas es el Índice de Vegetación de Diferencia Normalizada, conocido como 

NDVI por sus siglas en inglés (Toribio, 2019). Éste índice utiliza las señales espectrales en los 

rangos rojo e infrarrojo, y las relaciona mediante la siguiente ecuación: 

𝑁𝐷𝑉𝐼 =
𝑠𝑒ñ𝑎𝑙 𝑖𝑛𝑓𝑟𝑎𝑟𝑟𝑜𝑗𝑎 − 𝑠𝑒ñ𝑎𝑙 𝑟𝑜𝑗𝑎

𝑠𝑒ñ𝑎𝑙 𝑖𝑛𝑓𝑟𝑎𝑟𝑟𝑜𝑗𝑎 + 𝑠𝑒ñ𝑎𝑙 𝑟𝑜𝑗𝑎
 

El resultado obtenido son valores en el rango de -1 a 1, y mientras más alto el valor, mayor cantidad 

de vegetación hay en un área, o mejor salud tienen las plantas en esa región. La señal infrarroja 

obtenida de las plantas es mucho más fuerte que la obtenida en el rojo. Esto se debe a que la 

radiación infrarroja que proviene del Sol apenas llega al tejido mesófilo esponjoso de las hojas y 



rápidamente se refleja o dispersa. Por otro lado, la radiación roja logra llegar hasta los cloroplastos 

que se encuentran en el tejido de empalisada, y allí es absorbida en su mayoría durante la 

fotosíntesis. Esto provoca que los valores de la izquiera en la ecuación de NDVI sean mucho más 

altos que los valores de la derecha.  

Uno de los procesos humanos que está provocando cambios en la vegetación en estos 

últimos años en Puerto Rico es la construcción de proyectos solares industriales o a gran escala. 

Estos proyectos requieren grandes extensiones de terreno para poder producir una gran cantidad 

de energía a partir de la energía del Sol. En muchos casos, la construcción de estos proyectos 

conlleva remover terreno y vegetación con maquinaria para luego instalar los paneles solares, lo 

cual implica un gran impacto ambiental y un cambio drástico a la vegetación preexistente. 

Recientemente, se ha estado explorando la posibilidad de combinar la producción de energía solar 

de estos proyectos y la producción agrícola en los espacios debajo y entre los paneles solares. Este 

concepto recibe el nombre de Agrovoltaicos. La remoción de la capa superficial de suelo para 

instalar los paneles solares usualmente elimina nutrientes como el carbono y el nitrógeno, ambos 

esenciales para las plantas (Zhang et al., 2023). Al evaluar los cambios en vegetación a través del 

tiempo, se puede determinar si se pueden crecer plantas en esos lugares impactados. Sin embargo, 

no todas las plantas requieren la misma cantidad de nutrientes, por lo que el hecho de que la 

vegetación resurja en el lugar no significa que cualquier cultivo se podría sembrar allí sin una 

fertilización adecuada.  

 

Objetivos 

Mediante este trabajo, se calculará el Índice de Vegetación con Diferencia Normalizada 

antes, durante y después de la construcción de dos proyectos solares industriales en Puerto Rico. 

Con los valores de NDVI obtenidos alrededor y dentro de los proyectos, se puede evaluar la 

posibilidad de que crezca vegetación en estos espacios y de que se puedan crear proyectos 

agrovoltaicos en la Isla. 

 

Metodología 

Para este trabajo, se seleccionaron los proyectos Fonroche y Ciro One. El primero está 

ubicado en Humacao, y lleva varios años en operación desde el año 2016 (LORD, s.f.), mientras 

que el segundo se encuentra en Salinas, y su construcción se terminó a finales del año 2023 

(Energía Estratégica, 2023).  

Se utilizaron imágenes de la constelación de satélites Planet Scope, específicamente los 

satélites Dove y sus sensores Dove-C. Éstos tienen una resolución espacial de 3 metros y una 

resolución spectral de 4 bandas: azul, verde, rojo e infrarrojo cercano (NIR). Esta constelación es 

de uso comercial, y para obtener acceso gratuito a sus imágenes se creó una cuenta educativa en 

el portal Planet y se justificó el uso de las imágenes para estos propósitos. Estas imágenes ya 

cuentan con algunos pre-procesamientos, incluyendo corrección atmosférica. 



Para imágenes de principios del 2016 o de fechas anteriores, no habían imágenes de Planet 

Scope disponibles, en cambio, las imágenes que la Plataforma Planet Explorer tenía disponibles 

corresponden a la constelación de satélites Rapid Eye y sus sensores RapidEye Earth Imaging 

System (REIS). Estos sensores cuentan con una resolución especial de 5 metros y una resolución 

espectral de 5 bandas: azul, verde, rojo, rojo exterior e infrarrojo cercano. Estas imágenes son 

ortocorregidas y también cuentan con corrección atmosférica.  

Para extraer las imágenes de Planet Explorer, se localizó el lugar de interés, se 

seleccionaron el área y los rangos de fechas de interés, y se seleccionaron imágenes con muy poca 

o ninguna presencia de nubes o que tuvieran buena claridad. Manualmente se trazó un polígono 

alrededor del área de interés, luego se verificó que el archive tuviera las bandas espectrales 

necesarias (rojo e infrarrojo cercano), y se prodeció a descargar la imagen en formato .tiff. Para 

cada proyecto solar, se descargaron varias imágenes correspondientes a varias fechas en diferentes 

años, para así poder observar adecuadamente el cambio en cobertura vegetal. Se obtuvieron 

imágenes de las áreas de interés en su estado previo al desarrollo del proyecto, durante el desarrollo 

del proyecto y luego de completado el proyecto.  

Luego de obtenidas las imágenes, las mismas se procesaron en el programa ENVI. Se 

intentó aplicar la corrección atmosférica mediante el método Dark Subtraction a una imagen de 

cada proyecto solar, pero al verificar los valores con Cursor Value resultaron ser iguales a los de 

la imagen original, por lo que no fue necesario realizar este paso con las demás imágenes. Luego, 

a las imágenes se les realizó un mejoramiento en la visualización mediante la función Stretch, para 

que no se vieran tan oscuras. Después, se realizó el cálculo del NDVI mediante la función Band 

Math. Al algoritmo se le introdujo la siguiente ecuación: 

(𝑓𝑙𝑜𝑎𝑡(𝑏1ሻ − 𝑓𝑙𝑜𝑎𝑡(𝑏2ሻሻ/(𝑓𝑙𝑜𝑎𝑡(𝑏1ሻ + 𝑓𝑙𝑜𝑎𝑡(𝑏2ሻሻ 

donde a la variable “b1” se le asignaron los valores de la banda infrarrojo cercano (NIR) y a “b2” 

se le asignaron los valores de la banda roja. El término “float” se añade a la ecuación para asegurar 

que los valores de la señal de las bandas espectrales sean reconocidos como valores con dígitos 

decimales, y por lo tanto, los valores finales de NDVI también serán números con decimales entre 

-1  y 1 (ej. 0.634, -0.293). Al completar la ecuación, el programa corre el algoritmo y calcula el 

índice para cada imagen. La imagen producida inicialmente está en blanco y negro, por lo que se 

modificaron los colores mediante los pasos “Change Color Table→ Brewer Table→CB Greens”. 

Los colores verdes más intensos representan valores de NDVI más altos, y los colores más claros 

o blancos representan valores más bajos. En este caso, no se produjeron valores negativos, ya que 

estos valores usualmente ocurren en el agua, ya que ésta absorbe más la señal infrarroja que la 

roja. Luego de procesada la imagen, se le añadieron los elementos típicos de un mapa usando la 

función “Annotations”. Se añadió una flecha del norte, una escala, una barra de colores, las 

coordenadas y un título. Se guardó la imagen final mediante “File → Chip view to →File→ JPEG”, 

se le asignó un nombre al archivo y se guardó mediante “Save”. Lo mismo se realizó con la imagen 

satelital sin el NDVI, para poder hacer la comparación entre ambas imágenes. No fue necesario 

aplicar una máscara a las imágenes, ya que se quiere observar la diferencia en los valores de NDVI 

de las áreas con suelo desnudo, vegetación escasa, vegetación abundante y los paneles solares.  



Resultados 

En esta sección se muestran las imágenes procesadas en ENVI. Se presenta la imagen satelital y 

luego la imagen con NDVI para cada fecha seleccionada.  

1. Ciro One - Salinas 

a. Mayo 2022 

En estas imágenes se observa cómo estaba el terreno utilizado para el proyecto antes de 

su construcción. En el área oeste del proyecto hay vegetación leve, en su mayoría con valores de 

NDVI menores a 0.5 (Figura 2). En la parte este hay mayor densidad vegetativa, y los valores 

llegan hasta 0.68 y un poco más altos. Es posible que la región estuviera atravesando un periodo 

de sequía leve. Las zonas que siempre están en color blanco son las carreteras y construcciones. 

 

Figura 1. Imagen satelital Ciro One Mayo 2022 

 

Figura 2. Imagen NDVI Ciro One Mayo 2022 



b. Febrero 2023 

Aquí se observa que casi un año después, el proyecto ya está en desarrollo. La vegetación 

ha sido removida con maquinaria y algunos de los paneles solares ya han sido instalados. La 

imagen de NDVI muestra que el área que ha sido limpiada con maquinaria y construída tiene los 

colores más claros y los valores de NDVI más bajos. La región al norte presenta colores similares 

a los que tenía en la imagen anterior, pero la región al sur del proyecto muestra colores verdes más 

intensos que en la Figura 2. Los valores de NDVI más altos en esta imagen son iguales o mayores 

a 0.80, siendo mayores a los de la Figura 2. Los terrenos al sur y al oeste parecen ser agrícolas, por 

lo el aumento en vegetación pudo haber sido por un aumento en irrigación por sistemas de riego. 

Esta idea parece ser favorecida por el hecho de que los terrenos al norte se mantuvieron con una 

cobertura vegetal similar, por lo que quizás no se utilizan para agricultura y no han recibido lluvia. 

Además, febrero es usualmente un mes de sequía para la zona sur de Puerto Rico, incluyendo 

Salinas (NWS, 2024). En la Figura 3 se observan algunas nubes en las esquinas superior izquierda 

y superior derecha de la imagen, y éstas produjeron valores de NDVI muy bajos en la Figura 4. 

Sin embargo, las nubes no afectan mucha área de la imagen, por lo que el análisis aún es válido.  

 

Figura 3. Imagen satelital Ciro One Febrero 2023 

 

Figura 4. Imagen NDVI Ciro One Febrero 2023 



c. Abril 2023 

Dos meses después, se puede observar que el proyecto está más avanzado y ya cuenta con 

muchos más paneles solares instalados. Se limpió un área adicional al este con la maquinaria, y 

comenzó a crecer vegetación en el centro del proyecto. Los terrenos circundantes muestran una 

cobertura vegetal similar, reflejada en la Figura 6.  

 

Figura 5. Imagen satelital Ciro One Abril 2023 

 

Figura 6. Imagen NDVI Ciro One Abril 2023 



d. Junio 2023 

De nuevo han pasado dos meses desde las imágenes anteriores, y aquí se observa que se 

limpió otra parte del terreno al sureste y se han instalado paneles adicionales. Ha comenzado a 

crecer vegetación en la parte noreste del proyecto, cerca de los paneles. La vegetación circundante 

se ha mantenido similar a la de dos meses antes. Algunos paneles solares ya no se ven tan brillantes 

en la imagen satelital (Figura 7), y en la imagen de NDVI (Figura 8) se observa que ya no tienen 

colores blancos, sino que ahora se ven de color verde claro. Esto podría ser causado por el ángulo 

del Sol en el momento que se tomó la imagen, o la suciedad que se ha acumulado sobre los paneles.  

 

Figura 7. Imagen satelital Ciro One Junio 2023 

 

Figura 8. Imagen NDVI Ciro One Junio 2023 



e. Noviembre 2023 

Cinco meses después, ya se observa que el proyecto está completado y se han instalado 

todos los paneles solares. Esta época coincide con el final de la temporada de huracanes, y 

típicamente son meses lluviosos (NWS, 2024). Se observa un aumento considerable en la 

vegetación en los terrenos alrededor del proyecto. El cambio más drástico ocurrió en los terrenos 

del norte, que en los meses anteriores estaban bastante secos. Además, hay vegetación creciendo 

entre los paneles y cerca de ellos en muchas áreas, aunque quedan algunos espacios con suelo 

desnudo.  

 

Figura 9. Imagen satelital Ciro One Noviembre 2023 

 

Figura 10. Imagen NDVI Ciro One Noviembre 2023 



f. Abril 2024 

Esta imagen refleja el estado actual del proyecto. La vegetación disminuyó un poco en 

comparación a las imágenes de noviembre 2023. El cambio mayor se observa en los terrenos del 

norte. Aún hay bastante vegetación en la parte central del proyecto, pero la cobertura vegetal entre 

las filas de paneles y en el perímetro del proyecto disminuyó.  

 

Figura 11. Imagen satelital Ciro One Abril 2024 

 

Figura 12. Imagen NDVI Ciro One Abril 2024 
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Figura 13. Secuencia de imágenes satelitales antes, durante y después de la construcción de Ciro 

One: Mayo 2022 (1), Febrero 2023 (2), Abril 2023 (3), Junio 2023 (4), Noviembre 2023 (5) y 

Abril 2024 (6).  

 

Las Figuras 13 y 14 proveen una secuencia de las imágenes satelitales y NDVI para una mejor 

comparación entre imágenes del mismo tipo con relación al tiempo. 
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Figura 14. Secuencia de imágenes NDVI antes, durante y después de la construcción de Ciro 

One: Mayo 2022 (1), Febrero 2023 (2), Abril 2023 (3), Junio 2023 (4), Noviembre 2023 (5) y 

Abril 2024 (6). 

 



2. Fonroche - Humacao 

a. Noviembre 2014 

Aquí se observa el estado de los terrenos antes de la construcción del proyecto, el cual se 

ubica en Humacao, una región no tan seca como Salinas (NWS, 2024). La vegetación en esta zona 

era abundante cuando se tomó esta imagen del sensor Rapid Eye. Los valores de NDVI pasan de 

0.5 en la mayoría de la región. Al igual que con Ciro One, las zonas con colores blancos o muy 

claros en las imágenes satelitales son carreteras y edificios.  

 

Figura 15. Imagen satelital Fonroche Noviembre 2014 

 

 

Figura 16. Imagen NDVI Fonroche Noviembre 2014 



b. Febrero 2016 

En la Figura 17 se observa que ya para esta fecha se ha removido parte de la vegetación 

con maquinaria, lo cual se refleja en la Figura 18 con colores muy claros y valores de NDVI bajos 

en esa zona.  

 

Figura 17. Imagen satelital Fonroche Febrero 2016 

 

Figura 18. Imagen NDVI Fonroche Febrero 2016 



c. Noviembre 2016 

Ya para esta fecha se observa que los paneles solares fueron instalados en la zona limpiada 

por la maquinaria en las imágenes anteriores. Aún se observan colores muy claros y valores muy 

bajos de NDVI en la Figura 20, ya que los paneles reflejan la señal roja e infrarroja cercana de 

manera similar a como lo hacen los edificios y las carreteras. También se puede apreciar que ya ha 

comenzado a crecer vegetación en uno de los “pasillos” entre los paneles solares, ya que la imagen 

NDVI le asigna unos colores verde oscuro a esta franja de terreno. 

 

Figura 19. Imagen satelital Fonroche Noviembre 2016 

 

Figura 20. Imagen NDVI Fonroche Noviembre 2016 



d. Febrero 2017 

En la Figura 21 se observa que para esta fecha ya se había despejado una zona adicional de 

terreno con la maquinaria. La imagen NDVI refleja esta cambio (Figura 22) al aumentar el área 

con colores blancos o muy claros y valores de NDVI bajos.  

 

Figura 21. Imagen satelital Fonroche Febrero 2017 

 

Figura 22. Imagen NDVI Fonroche Febrero 2017 



e. Diciembre 2017 

En la Figura 23 se observa que a finales de ese mismo año, ya se comenzaron a instalar los 

paneles solares en la última área que fue despejada por la maquinaria. Interesantemente, muchos 

de los paneles recién instalados y áreas donde solo habían cimientos pero todavía no habían 

paneles, y muchos de los paneles más antiguos, comenzaron a mostrar valores de NDVI más altos 

y colores verdes claros y moderados (Figura 24). 

 

Figura 23. Imagen satelital Fonroche Diciembre 2017 

 

Figura 24. Imagen NDVI Fonroche Diciembre 2017 



f. Diciembre 2018 

La Figura 25 muestra que para esta fecha, ya la gran mayoría de los paneles solares fueron 

instalados en el proyecto. La imagen NDVI (Figura 26) muestra que los valores de los paneles 

disminuyeron y están más cerca de sus valores iniciales, demostrado por colores más claros. 

Además, unas cinco franjas o “pasillos” entre los paneles muestran crecimiento vegetativo.  

 

Figura 25. Imagen satelital Fonroche Diciembre 2018 

 

Figura 26. Imagen NDVI Fonroche Diciembre 2018 



g. Diciembre 2020 

La Figura 27 muestra que para esta fecha, la vegetación más cercana al proyecto disminuyó 

en su densidad levemente. Esto lo confirma la imagen NDVI con colores más claros. Además, los 

paneles volvieron a mostrar valores más altos de NDVI y colores más verdosos, disminuyendo el 

contraste con la vegetación circundante.  

 

Figura 27. Imagen satelital Fonroche Diciembre 2020 

 

Figura 28. Imagen NDVI Fonroche Diciembre 2020 



h. Abril 2021 

Para esta fecha, la imagen satelital y la imagen NDVI reflejan una disminución 

significativa en la vegetación alrededor del proyecto. Por otro lado, los paneles solares siguen 

mostrando colores verdosos en la Figura 30, y el contraste entre éstos y la vegetación circundante 

es aún menor. Alguien que observe la imagen NDVI sin observar la imagen satelital podría pensar 

que el área ocupada por los paneles es vegetación. Los pasillos entre los paneles que tenían 

vegetación en imágenes anteriores aún la mantienen, y reflejan colores verde más intensos que los 

paneles solares. 

 

Figura 29. Imagen satelital Fonroche Abril 2021 

 

Figura 30. Imagen NDVI Fonroche Abril 2021 



i. Abril 2024 

Las Figura 31 y 32 muestran el estado actual del proyecto y de la vegetación. Ahora hay 

más cantidad de pasillos entre los paneles con vegetación. La vegetación alrededor del proyecto 

aumentó en comparación con las imágenes de abril 2021, pero el contraste entre los paneles solares 

y la vegetación sigue siendo poco. Solo algunos paneles solares redujeron sus valores de NDVI.  

 

Figura 31. Imagen satelital Fonroche Abril 2024 

 

Figura 32. Imagen NDVI Fonroche Abril 2024 



Conclusiones 

 Mediante la observación de imágenes satelites e imágenes del Índice de Vegetación de 

Diferencia Normalizada (NDVI, por sus siglas en inglés), se puede concluir que es posible que la 

vegetación vuelva a crecer en los espacios entre los paneles solares y en los alrededores de éstos, 

aunque no necesariamente en la totalidad de estas áreas. Hay algunos factores que pueden causar 

que no crezca vegetación en algunas áreas entre los paneles o alrededor de éstos, tales como el uso 

frecuente de maquinaria en esa área, una alta compactación del terreno durante la construcción del 

proyecto, que se haya colocado grava o algún material de relleno, las épocas de sequía, entre otros. 

Esto podría explicar el hecho de que en las imágenes se observaron algunas regiones en las que 

nunca creció vegetación, y otras en las que en algunos meses se observaba más vegetación, y en 

otros meses disminuía. Por otro lado, la resolución de las imágenes utilizadas, que fue de 3 y 5 

metros, pudo haber causado que no se vieran muchos de los pasillos entre los paneles solares, los 

cuales podían o no tener vegetación.  

Adicional a eso, mediante las imágenes satelitales no se puede saber si ha crecido la 

vegetación debajo de los paneles solares, ya que éstos desvían la radiación y evita que alcance el 

suelo que está justo debajo. Para esto, se necesita de fotos tomadas desde aviones, con drones o 

durante visitas de campo en el lugar. La Figura 33 muestra que casi todos los pasillos tienen 

cobertura vegetal en el proyecto Ciro One en Salinas. Además, visitas de campo al lugar 

confirmaron que hay mucha vegetación debajo de los paneles. El total de la vegetación en este 

proyecto es hierba común (Sepúlveda, 2024). Con esto, se deja al descubierto una limitación de la 

percepción remota al aplicarla al estudio de proyectos solares a gran escala.  

 

Figura 33. Foto aérea del proyecto Ciro One (Energía Estratégica, 2023)  

 



Las Figuras 34 y 35 también evidencian el crecimiento vegetativo en los pasillos y debajo de los 

paneles solares, en este caso en el proyecto Fonroche en Humacao. 

 

Figura 34. Foto aérea Fonroche (LORD, s.f.) 

 

Figura 35. Vista lateral del proyecto Fonroche (GPJ, 2024) 



En la Figura 35 se observa que, además de la hierba común, hay arbustos creciendo debajo de los 

paneles, y han alcanzado la altura suficiente como para atravesar el conjunto de paneles y crecer 

por encima de éstos.  
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Figura 36. Secuencia de imágenes satelitales antes, durante y después de la construcción de 

Fonroche: Noviembre 2014(1), Febrero 2016 (2), Noviembre 2016 (3), Febrero 2017 (4), 

Diciembre 2017 (5), Diciembre 2018 (6), Diciembre 2020 (7), Abril 2021 (8) y Abril 2024 (9).  



Las Figuras 36 y 37 proveen una secuencia de las imágenes satelitales y NDVI para una mejor 

comparación entre imágenes del mismo tipo con relación al tiempo. 
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Figura 37. Secuencia de imágenes NDVI antes, durante y después de la construcción de Fonroche: 

Noviembre 2014 (1), Febrero 2016 (2), Noviembre 2016 (3), Febrero 2017 (4), Diciembre 2017 

(5), Diciembre 2018 (6), Diciembre 2020 (7), Abril 2021 (8) y Abril 2024 (9). 

 



Recomendaciones 

Para poder determinar con mayor exactitud qué cultivos agrícolas se pueden producir 

debajo de los paneles, lo mejor es recolectar muestras de estos suelos y analizarlas en un 

laboratorio para determinar qué nutrientes tienen. La hierba común y los arbustos silvestres son 

menos exigentes nutricionalmente en comparación a la gran mayoría de los cultivos agrícolas, por 

lo que el hecho de que éstos logren crecer en estos proyectos luego de su construcción, no asegura 

que otras plantas o cultivos también lo puedan hacer.  

Además, para futuros estudios de cobertura vegetal en proyectos solares industriales, en 

los que el espacio entre los paneles es de unos pocos pies, lo mejor sería utilizar imágenes 

satelitales de mayor resolución espacial, preferiblemente de un metro o menos por pixel. El 

problema es que los sensores que proveen imágenes de esas resoluciones son comerciales o de uso 

privado, y el costo para adquirir esas imágenes es muy elevado. Las imágenes de Planet son las de 

mejor resolución espacial entre las que se pueden obtener de manera gratuita. No se puede olvidar 

el hecho de que las imágenes satelitales no permiten ver lo que hay debajo de los paneles solares. 

Si se usan imágenes de éste u otros satélites o sensores, el estudio se debe complementar con 

fotografías de aviones, drones o tomadas por personas en visitas de campo, que muestran mejor lo 

que hay entre y debajo de los paneles.  

Para un próximo estudio, también se podría aplicar una máscara a los paneles solares y los 

edificios en las imágenes satelitales, para que el NDVI solo tome en consideración el espacio entre 

ellos.  
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